Welcome to Remote Access

Remote Access enables you to use a PC to access a remote controller. During a Remote Access session, the remote controller is displayed, on-line, on your PC screen. You can ‘press’ keypad keys and touch-screen objects, check system status and run-time values, as well as test and troubleshoot problems in remote controllers and applications. You can access:

- Stand-alone controllers that are directly connected to the PC via a cable.
- Controllers within a network.
- Either stand-alone or networked controllers via GSM or landline modem.
- Devices with IP addresses, via Ethernet.

Remote Access can be used with either Vision or M90/91 controllers. Vision controllers require O/S versions 2.96 and higher; M90/91 require V3.00 and higher.

Using Remote Access

The Remote Access package includes additional utilities:

- M90 Downloader
- Operand Access
- Data Tables
Using Remote Access

Selecting an OPLC model
Select the controller model from the Configuration menu.

![Image of OPLC model selection]

**Note**
- Vision model controllers:
  Select the model. If the controller is in a network, open Communication-PC Settings from the options menu, and select the controller's ID number.
- M90/91 model controllers within a network:
  Select which type of network, and then select the controller's ID number.

**Communication-PC Settings**
This enables you to check communication parameters and perform certain actions.
- PC Communication Settings
- Run, Reset, Initialize
- Get Com Parameters and PLC status
- Check Network Status

**Remote Access via Modem**
To access either stand-alone or networked controllers via GSM or landline modem:
Modems: Setting Up

**PLC-Modem Connection**

**The PC must be:**
- Connected to a modem
- Be installed with Remote Access
- Be correctly configured

**The controller must be:**
- Connected to a modem
- Installed with a program supporting Remote Access.
**PC Modem Configuration**

Open PC Modem Configuration from the **Configuration menu**.
Remote Access

Online Mode

Once you have configured Remote Access, enter Online mode by clicking the button.

In this mode, you can:

- Use your cursor to operate the controller keypad and activate touch-screen objects (relevant models).
- Use your PC keyboard to operate the controller keypad (numeric keys, function keys <F1> to <F8>). Note that the Vision <ESC> key is <E> on the PC keyboard, and that <F9> is reserved for activating Online mode.
- Enter Information Mode by pressing the <i> key with your cursor.
- Select a View.

Note: The Zoom option on the View menu can be activated only if you select Hide Keys. Zoom cannot be used with M90/91 or V280 controllers.
PC Com Parameters (non-modem)
Display the current communication settings by selecting Communication - PC Settings from the Options menu.

<table>
<thead>
<tr>
<th>Select Connection type</th>
<th>Use the drop-down arrow to select serial or Ethernet.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC Com Parameters</td>
<td>Port, Retries and Time-Out are the communication settings between Remote Access and the controller. Note that if you are working with a network, the TimeOut should be greater than 1 second.</td>
</tr>
<tr>
<td>Communicate with OPLC</td>
<td>Use these options to communicate with networked controllers. <strong>Direct Connection</strong>: select this to communicate with any controller that is connected to your PC via the download cable, including a network bridge. <strong>Within Network</strong>: select this to communicate with a controller that is integrated into a network, then select the controller’s ID number.</td>
</tr>
<tr>
<td>Vision OPLC Information</td>
<td>Click <strong>Get OPLC Information</strong> to display information about the controller you have selected in <strong>Communicate with OPLC</strong>.</td>
</tr>
</tbody>
</table>
Remote Access

Select Ethernet to display Favorites.

Select Connection Type: Ethernet.

Click on the Favorites folder to define IPs.

Favorites:

**Favorites (Ethernet Addresses)**

<table>
<thead>
<tr>
<th>IP Address</th>
<th>Protocol</th>
<th>Port Number</th>
<th>PLC Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 192.168.132.5</td>
<td>UDP</td>
<td>20000</td>
<td>Entrance</td>
</tr>
<tr>
<td>2 192.168.132.6</td>
<td>UDP</td>
<td>20000</td>
<td>Exit</td>
</tr>
</tbody>
</table>

Get OPLC Information

Exit
Run, Reset, Initialize

Note ♦ When you click a button, your PC will access the controller selected in PC Communication Settings.

Set RTC
These are the values of your PC’s clock. Click Set RTC to import these values into the RTC of the controller.

Get Vision RTC Current Values
Click to view the current PLC settings.

Run
Click to run the current program in the PLC.

Stop
Click to stop the current PLC program.

Reset
Click to reset the PLC, and reinstall any values preset in the program, such as Timers.

Reset & Initialize
Click to reset, reinstall any preset values, and initialize all memory operands.
Get Com Parameters and PLC status

Select Get to view communication parameters and PLC status in the controller you are currently communicating with.

This is the controller selected in PC Communication Settings.
Check Network Status

The network status is checked via the bridge.
Remote Access via Modem

To access either stand-alone or networked controllers via GSM or landline modem:

**Note** ♦ The PC-modem cable is not the same type of cable used to connect between the controller and the modem. Ensure that the cable used to connect the PC to the modem provides connection points for all of the modem's pins.

♦ Both PC and controller must use the same type of modem: either landline or GSM.

♦ Internal modems must be used in conjunction with the driver provided by the modem's manufacturer.

♦ If calls are routed via a switchboard, note that the switchboard settings may interfere with communications. Consult with your switchboard provider.

**Modems: Setting Up**

*PLC-Modem Connection*
Remote Access

PC Modem Configuration

Open PC Modem Configuration from the Configuration menu.
Remote Access via Modem (PC-Modem Configuration)

1. Select either GSM or PSTN standard modem.

2. Edit the initialization commands, settings, or restore defaults.

3. Select dialing type.

4. Click in a field to enter a phone number and description.

5. You can dial an outside line by entering the access number required, followed by a comma and then entering the actual phone number.

6. Click in the field, then type the SMS message.

7. Click to send the message.

Selecting GSM modem activates the SMS field at the bottom of the box.
Operand Access

Operand Access is located on the *Tools menu*. This utility enables you to access operands in a local or remote controller and perform the operations listed below.

1. **View remote operands in the Operand Access table, then define and name regions.**

   To define regions:
   
   1. Click and drag the cursor over regions to select them.
   2. Click the Add New Region button.

2. **Save region definitions in .vxt files.**
In order to open a .vxt file, you must select the controller series (Configure>OPLC model, either Vision or M90/91) which was selected when the .vxt file was saved.

- **View real-time operand values in Online mode.**

  1. Click the Online icon; real-time values appear in blue.

- **Read operand values from the controller.**

  1. Click the Read icon; all values are read in all of the defined regions.
Write MB, MI, ML and DW values to the controller.

**Note** ♦ You can also write values to the M90 Database integers.

1. Enter values, then click write; all of the values in all of the defined regions are written to the controller.

Use the Windows Clipboard to Cut/Copy/Paste values to/from the Operand Access table and third-party editors such as Excel.

**Note** ♦ The Paste destination within Operand Access must be large enough to hold the Clipboard contents. Clipboard contents are pasted to the right and down.
Remote Access

- **Export/Import Operand values to/from an Excel spreadsheet customized to Unitronics’ PLC Data Types.**

  Within Excel, values can be edited, imported to Operand Access, then written to the controller.

  ![Excel Spreadsheet](image)

  To export real-time values from the PLC to Excel:
  
  1. Create a region containing the operand values you wish to export.
  2. Select Read Regions in order to update those values.
  3. Select Export to Excel.

  **Note**: Not all operand values are updated with real-time values when you run On Line mode. When you run On Line mode, only the values that are displayed within the Operand Access window are updated. Operands that are not displayed in the Operand Access window during On Line are not updated.

  Therefore, running On Line mode immediately before Export to Excel does not guarantee the export of all updated operand values.
M90 Downloader

M90 Downloader enables you to install control applications in local or remote M90/91 controllers. These applications are in .d90 format.

The utility is located on the Tools menu.

To download files:

1. Select a work mode. The Network definitions are set in the Remote Access PC Com Parameters (non-modem)
2. Click Select File; the Select file box opens.
3. Navigate to the desired .d90 file, then click Download to install the application in the controller.
Information Mode

Information Mode is a utility that is embedded in the operating system of the controller. Via Information Mode, you can view data on the LCD screen, use the controller’s keyboard to directly edit data, and perform certain actions such as resetting the controller. You can enter Information Mode at any time without regard to what is currently displayed on the LCD screen.

Enter Information Mode by pressing the <i> key for a few seconds. The default password is 1111.

Viewing data does not affect the controller’s program. Performing actions, such as initializing the controller, can influence the program.

Note ♦ When you use Information Mode, the keyboard is dedicated to that purpose. The keys return to normal application functions when you exit Information Mode.

Using Information Mode

1. To enter Information mode, press the <i>button on the Vision’s keyboard.
2. Enter your password. The default password is 1111. This password remains in effect until you change it via the Information Mode screen described in the table below.
3. The controller enters Information Mode, showing the first category, Data Types.

The controller will block entry into Information mode until the correct password has been entered. This is why you must record any password you set for your controller.

The data in Information Mode is arranged in Categories. Each Category contains several Subjects. You navigate Information Mode by using the keyboard buttons.

To exit Information mode, press the <ESC>button on the Vision’s keyboard. Each press returns one level up. Press the number of times necessary to exit.

Note ♦ When you reenter Information Mode, the controller will return to the last Category viewed.
The table below shows the categories of information that can be accessed in this mode.

<table>
<thead>
<tr>
<th>Category</th>
<th>Subject</th>
<th>Possible Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Types</td>
<td>Memory Bits</td>
<td>• View bit status</td>
</tr>
<tr>
<td></td>
<td>System Bits</td>
<td>• Change bit status (Set/Reset)</td>
</tr>
<tr>
<td></td>
<td>Memory Integers</td>
<td>• View integer/long integer/double word value.</td>
</tr>
<tr>
<td></td>
<td>System Integers</td>
<td>• Change values</td>
</tr>
<tr>
<td></td>
<td>Memory Longs</td>
<td>• Toggle Base: view the value in decimal or hexadecimal form.</td>
</tr>
<tr>
<td></td>
<td>System Longs</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory Double Words</td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Double Words</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inputs</td>
<td>• View input status.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Force input status to 1 (FR1) or 0 (FR0). Forced values stay in effect until Normal mode (NRM) is selected, or until the controller is initialized or reset.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong>: Forced values do influence your program. This can be useful in testing the effect of an input condition on an output status.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Outputs</td>
<td>• View output status.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Force output status to 1 (FR1) or 0 (FR0). Note that forced output values do not affect your program.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Set/Reset output status.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Timers</td>
<td>• Enter a Preset Timer value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View the current timer value and status by selecting the R.T. option.</td>
</tr>
<tr>
<td></td>
<td>System</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Model &amp; O/S Ver</td>
<td>• Check the controller’s model number and operating system version.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check whether the controller is in Run or Stop mode.</td>
</tr>
<tr>
<td></td>
<td>Working Mode</td>
<td>• Check whether the controller is in Run or Stop mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reset the controller. This restarts your program; restoring power-up values to all data types except for those protected by the battery memory backup.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Initialize the controller. This restarts your program and initializes all values, restoring 0 values to all data types.</td>
</tr>
<tr>
<td></td>
<td>Time &amp; Date</td>
<td>• View the Real Time Clock (RTC) settings. Note that the RTC settings control all time-based functions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Change the RTC settings via the controller’s keyboard.</td>
</tr>
<tr>
<td></td>
<td>Unit ID</td>
<td>The Unit ID number identifies a networked controller. You can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Change the ID number. The new ID number will remain in effect until the controller is reset.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Burn the ID number into the controller’s FLASH.</td>
</tr>
</tbody>
</table>
### Information Mode

<table>
<thead>
<tr>
<th>Memory</th>
<th>This is a permanent change.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Port 1</td>
<td>View and edit communication settings.</td>
</tr>
<tr>
<td>Serial Port 2</td>
<td>Select to Change or Burn the new settings.</td>
</tr>
<tr>
<td>CANbus Baud Rate</td>
<td>Change the CANbus baud rate.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function Block</th>
<th>Reserved for future use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>New Set a New Password</td>
</tr>
<tr>
<td>Hardware Configuration</td>
<td>Check if I/O Expansion Modules are installed. Note that I/O Expansion Modules are represented by letters. Identical module types are represented by identical letters as shown below. Shows if an I/O module is short-circuited.</td>
</tr>
</tbody>
</table>

#### Diagram

- Identical letters signify identical I/O Expansion Module types.
- Shows that I/Os on Snap-in Module are not short-circuited.
- X-no I/O Expansion Module installed.
- Shows that an I/O on Expansion Module #5 is short-circuited.
## Index

<table>
<thead>
<tr>
<th>C</th>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Parameters...........................7</td>
<td>O/S............................................................ 7</td>
</tr>
<tr>
<td>I</td>
<td>R</td>
</tr>
<tr>
<td>Initialize....................................9</td>
<td>Remote Access............................ 3, 19, 23</td>
</tr>
<tr>
<td>N</td>
<td>Reset.................................................... 9</td>
</tr>
<tr>
<td>Network........................................7, 13</td>
<td>RTC settings ........................................ 9</td>
</tr>
</tbody>
</table>